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1.0 Introduction 

1.1 i500™ Plus Description 
The i500™ Plus is the best in class thermal printer with the widest range of features. It 
generates text and barcode through thermal transfer printing at speed of 5 labels per 4 
seconds at a print density of 203 dpi.  Its ability to integrate with other BioGenex 
systems along with a wide variety of interface and feature options makes it user 
friendly to the core. 
Features of this system include: 

� Simplified media loading. 
� Print up to 7 lines of text. 
� Auto date function. 
� Label setup and comment save option. 
� High quality chemical and heat resistance labels. 
� Compatible with LIS. 

 

 



   
  i500TM Plus Operator’s Manual   

- 5 - 
 

 

i500TM Plus 
LIS Enabled Barcode Label Printer 

 

1.2 Printer Overview 
The front View of i500™ Plus 

   

 

The back view of i500™ Plus 
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Number Name 

1 Release latches 

2 Status light 

3 Feed button 

4 Power button 

5 USB port 

6  DC power port 

 

 

1.3 Cautions and Warnings 
 

Icon Caution 

 
Warns you of the potential for electrostatic discharge. 

 

Warns you of a potential electric shock situation. 

 

Warns you of a situation where excessive heat could cause a burn. 

 

Advises you that failure to take or avoid a specific action could result in 
physical harm to you. 
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2.0 Installation and Configuration 

2.1  Package Contents 
� 1 Printer 
� 1 Roll of labels (inside printer) 
� 1 Printer ribbon (inside printer) 
� 1 Power adapter  
� 1 Power cord for power adapter 
� 1 USB cable 
� 1 Operator’s manual 

 
2.2 Printer Installation Instructions 

� Set up the printer next to the PC. 
� Make sure the power switch is in the OFF (O) position. 
� Connect the cord extending from the power supply unit to the back of the 

printer. Once the connection is made, tighten the connector. 
� Next, making sure the PC and printer are off, plug in the wider side of the 

printer cable into the back of the printer. Then plug in the other side into the 
printer port on the back of the PC. 
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� Finally, turn on the PC. Then turn on the printer by placing the power switch in 
the ON (l) position. Proceed with software installation. 

 
2.3 Software Requirements 

� Windows® 10 64 bit Operating System. 
� Minimum  4 GB of RAM. 
� Minimum   250GB of Hard Drive Space. 

 
2.4 Label Roll Installation  

� To access the media compartment, open the printer by pulling the release 
latches towards you and lift the cover. 

� Use the correct media for the type of printing required. Remove the outside 
length of media to avoid dragging adhesive or dirty media between the print-
head and platen. 

� Open the media roll holders. Pull the media guides open with your free hand 
and place the media roll on the roll holders and release the guides. Orient the 
media roll so that its printing surface will face up as it passes over the platen 
(drive) roller. 

� Pull the media so that it extends out of the front of the printer. Verify the roll 
turns freely. The roll must not sit in the bottom of the media compartment. 
Verify that media’s printing surface is facing up. 

� Push the media under the media guides and close the printer by pressing down 
until the cover snaps closed 
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2.5 Ribbon Overview 

Ribbon is a thin film that is coated on one side with wax, resin, or wax resin, which is 
transferred to the media during the thermal transfer process. The media determines 
whether you need to use ribbon and how wide the ribbon must be. When ribbon is 
used, it must be as wide as or wider than the media being used. If the ribbon is 
narrower than the media, areas of the print-head are unprotected and subject to 
premature wear. 

1 

2 

3 
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When to use a ribbon? 

Thermal transfer media require ribbon for printing while direct thermal media does 
not. Direct thermal media should never be used with ribbon. Bar codes and graphics 
can get distorted. To determine if ribbon must be used with a particular media, 
perform a media scratch test. 

2.5.1 Ribbon Scratch Test 

Perform the ribbon scratch test when labels are unavailable. To perform a ribbon 
scratch test, complete these steps: 

1. Unroll a short length of ribbon. 
2. Place the unrolled section of ribbon on a piece of paper with the outer surface 

of the ribbon in contact with the paper. 
3. Scratch the inner surface of the unrolled ribbon with your fingernail. 
4. Lift the ribbon from the paper. 
5. Observe the results. Did the ribbon leave a mark on the paper? 

If the ribbon… Then… 
Left a mark on the paper 
 

The ribbon is coated on the outside and can be 
used with this  printer 

Did not leave a mark on the paper 
 

The ribbon is coated on the inside and cannot be 
used 
 

 
2.5.2 Thermal Ribbon Installation  

� Prepare the ribbon by removing its wrapping and pulling its adhesive strip free. 
� With the printer open, place a new ribbon roll on printer’s lower ribbon supply 

spindles. 
� Place an empty ribbon core on printer’s take-up spindles. Rotate the ribbon 

core until the notches align and lock into the left side of the take-up hub. 
� Pull the transfer ribbon’s leader off the roll and attach it with the adhesive strip 

on the leader to the empty ribbon core on the supply spindle. Center the ribbon 
on the ribbon core. 

� Rotate the thumb wheel on the left side of the supply spindle until the ribbon is 
pulled tight across the print-head. 

� Verify that the media is loaded and ready to print and then close the printer 
cover. 
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� Press the Feed button to have the printer feed a minimum of 10 cm (4 inches) 
of media to remove slack and ribbon wrinkle, and to align the ribbon on the 
spindles. 

� Printer is now ready to print 
 

Note: Always use a ribbon that is wider than the media to protect the print-head 
from wearing. 
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3.0 System Specifications 

� Dimensions 
267mmL X 197mm W X 191mm H 

� Weight 
2.5 lbs/1.1 kg  

� Adapter’s Electrical Specifications 
Input: 100-240V, 2.8A 50-60Hz 
Output: 24V, 4.1A, 100W Maximum 

� Normal Operating Temperature 
40° to 105° F/4.4° to 41° C 

� Storage Temp 
-40° to 140° F/-40° to 60° C 

� Label Capacity 
2000 labels per roll 

� Print Speed 
6 in./152 mm per second or 4 in./102 mm per second 

� Operating System 
Windows® 10 64 bit OS 
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4.0 Printer Panels 
4.1 LED Status  

Located on the top case next to the feed button, the status light functions as a printer  
operational indicator 

 

 
 

What the Status Light is telling you 

LED Status and Color Printer Status Reason 

Off Off The printer is not receiving power 

Solid Green On The printer is on and in an idle state 

Solid Amber Stopped The printer has failed its power on self test (POST) 

Flashing Green Normal operation The printer is receiving data 

Flashing Red Stopped The media is out OR Print-head is open 

Double Flashing Green Paused Printer is paused 

Flashing Amber Paused The print-head is over heated 

Alternately Flashing 
Green and Red 

Needs Service FLASH memory is not programmed 

Flashing Red, Red and 
Green 

Needs Service The print-head or motor has had a critical failure. 

 

Status Light Feed Button
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4.2 Feed Button  
Press the Feed button to – 

� Force the printer to feed one blank label. 
� Take the printer out of a “pause” condition. The printer is put into 

“pause” by either a programming command or an error condition. 
� Go to printer setup and status. 

 
4.2.1 Feed Button Modes 

 

Power Off Mode (Communications Diagnostics Mode) 

With the printer power off, press and hold the Feed button while you turn on the power  

Flash Sequence Action 

Rapid Red Flashing 

Firmware Download Mode - The printer starts rapidly flashing red to 
denote entry into the Firmware Download m ode. Releasing the Feed 
button here will start initializing the printer f or download. The printer 
is ready to start downloading firmware when the status light begins to 
slowly flash between red and green. 

 

Amber 

Normal Operations Mode - The printer continues into a normal printer 
initialization. Releasing the Feed button here will allow the printer to 
start normally without firmware download or operating in 
communications diagnostics mode. 

 

Green 

 

Communications Diagnostic (Dump) Mode - Release the Feed button 
immediately after the printer status light turns green. The printer will 
print ‘Now in DUMP’ at the top of the label and then advance to the 
next label. After printing the first label, the printer will automatically 
enter into diagnostic mode in which the printer prints out a literal 
representation of all data subsequently received. 
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5.0 Using Software 
5.1 Working with i500TM Plus  

The toolbar and menu bar options unless specified below are very similar in function to 
those found in many other Windows applications. The ‘Save Label’ option saves the 
values given for each field in the label setup. These setups can then be opened using 
the ‘Open’ option. “New” option just creates a new setup. 

5.1.1 Printing Labels 

� Once the software is installed (Refer to section 2.4), start the program by 
double clicking on i500™ Plus icon. 

 
� The <Product Selection> window will open. 

 
� Depending on the BioGenex product being used, the user may select any of the 

three options 
� i6000™ Automated Staining System 
� i6000VIP Automated Staining System 
� XmatrxElite® Automated Staining System 
� NanoVIP Automated staining System 
� NanoMtrx100 Automated staining System 
� NanoMtrx300 Automated staining System 
� NanVIP300 Automated staining System 
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� In order for the user to ensure that the software always selects the same unit 
they may click on the “Remember this Selection” option. 

� To synchronize the i500TM Plus with the particular run of the day the user may 
select the SYNC option. Once the user clicks on “OK”, the <LIS Intermediate 
Selection> window will be displayed subsequently. 

 
� Select ‘Connect to LIS Intermediate’ if there is access to Laboratory Information 

System (LIS). Contact BioGenex for LIS connectivity option.    
� Select ‘Skip LIS Intermediate’ if there is no access to LIS and click ‘OK’. 
� The <Barcode Labeler Plus> window will open.  The name of the instrument 

synchronized will appear below the menu bar. 
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� Once the <Barcode Labeler Plus> window is open, the user can select up to 

seven fields of information as needed on the barcode label.  
� Click on the check boxes adjacent to the respective fields to include in the 

barcode label 
 

 
5.1.2 Creating Labels 

� The Protocol Description field will change depending on the initial 
synchronization with i6000™/i6000VIP / NanoVIP/ NanoMtrx100/ 
NanoMtrx300/ NanoVIP300/ XmatrxElite staining systems.  
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� Click on the arrow to select the protocol from the drop down Menu. This will 
add the protocol name to the barcode label, a preview of which is displayed on 
the right.  

� Once the protocol name is entered, the remaining fields are optional. Additional 
information such as, Accession Number, Physician Name, Patient Name, and 
Date can be added by manually typing in the respective fields. 

� If LIS is accessible, specifying the accession number will automatically load the 
patient information in the respective fields. 

  
When LIS is not accessible, patient information  

entered manually 
When LIS is accessible, patient information 

automatically loaded by entering the Accession No. 
5.1.3 Addition / Deletion of Labels to the Spool 

� Once the required information is entered, it can be added to the spool using the 
print spool option. 

� Specify the number of labels desired, under the Quantity option and click on 
"Add to Spool" option to add the labels to be printed in the spool box 

 
� To remove a label from the spool, select the label and click on "Remove from 

Spool" option. 
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� Clicking on “Remove All from Spool” opens a warning message. Click on ‘yes’ to 
delete all the labels from the spool. 

 

  
 

 
 
 

5.1.4  Update Label and Test Print 
� Changes can be done to any of the labels in the spool using the Update Label 

option. Select the label from the spool and change the Protocol Description OR 
patient information OR quantity as applicable. Click on Update Label to apply 
the changes to the existing label. 

� In order to “Test Print” a single label, the user may select the label they wish to 
see, and click on Test Print. This option will print only ONE label. 
 

 
� Click on ‘Print Spool’ to proceed with printing.  A maximum of 99 labels can be 

printed in one go. 
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5.2 Menu Options  

 

5.2.1 File  

The following options are available under the ‘File Menu’. 

 

Function 

Opens a new window to create new labels 

Opens files which have been previously saved in the appropriate databases 

Saves the labels that are present in the spool  

The user can populate the different fields using this option 

The default settings are ZPL Commands.  

Exit the application 

5.2.1.1  Manage User Fields:  

 

The user can populate the different fields using this 
option. 
a) Type in New record and click on ‘Add’ to add 

contents to the database. 
b) Click on ‘Delete’ to remove record. 
c) Click on ‘Cancel’ to cancel the entry. 
d) Click on ‘Done’ to save entry and close this field. 
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5.2.2  Operations 

The following options are available under the ‘Operations Menu’. 

 

Function 

Display the date of creation, product name along with comments if any 

Add label information to the spool for it to be printed  

Update any of the labels in the spool 

Print labels present in the spool 
Prints only ONE label as an example 

Removes a single selected label from the spool 

Removes all labels from the spool 

 

5.2.3  View 

The following options are available under the ‘View Menu’. 

 

Function 

This preview will show an HTML version of the label 

This preview will show a thumbnail version of the label 

 

 

Html view of Labels 
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Thumbnail view of Labels 

5.2.4 Help 

The following options are available under the ‘Help Menu’. 

 

Function 

The Software version will be displayed 
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6.0 Label Use 
6.1 Perforation 

The labels provided with this system are perforated towards the top. These labels are 
customized for use with the i6000TM, XmatrxElite®, i6000VIP, NanoMtrx100, 
NanoMtrx300, NanoVIP & NanoVIP300 systems. The perforated portion is meant to 
wrap around to the back of the side. To do this, attach the label so that the perforation 
is close to the top of the slide and then wrap the extended portion of the label over the 
edge of the slide. 

 
 

Note: The label should be placed on the slide before processing the slide. Place the 
label on the frosted side of the slide and apply the label firmly.  
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7.0 Printer Maintenance 
7.1 Cleaning Print-head 

Always use a new cleaning pen on the print-head (an old pen carries contaminants 
from its previous uses that may damage the print-head). 

 

 

Caution – The print-head becomes hot while printing. To protect from 
damaging the print-head and risk of personal injury, avoid touching 
the print-head. Use only the cleaning pen to perform maintenance. 

 
� Rub the cleaning pen across the dark area of the print-head. Clean from 

the middle to the outside. This will move adhesive transferred from the 
edges of media to the print-head outside of media path. 

� Wait one minute before closing the printer. 

 
Note: Clean the print-head after every roll of ribbon 
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7.2 Cleaning Platen (Drive Roller) and Replacement 
The standard platen normally does not require cleaning. Paper and liner dust can 
accumulate without effecting print operations. Contaminates on the platen roller can 
damage the print-head or cause the media to slip or stick when printing. Adhesive, dirt, 
general dust, oils and other contaminates should be cleaned immediately off the 
platen. 
Clean the platen (and media path) whenever the printer has significantly poorer 
performance, print quality or media handling. The platen is the print surface and drive 
roller for your media. If sticking or jamming continues even after cleaning, you must 
replace the platen.  
The platen can be cleaned with a fiber-free swab or a lint free, clean, damp cloth very 
lightly moistened with medical grade alcohol (90% pure or better). 

 
� Open the cover (and dispenser door). Remove media from platen area. 
� Pull the platen bearing latch release tabs on the right and left sides 

towards the front of the printer and rotate them up. 
� Clean the platen with the alcohol moistened swab. Clean from the 

center outwards.  
� Repeat this process until the entire roller surface has been cleaned. If 

there has been heavy adhesive build-up or label jam, repeat with a new 
swab to remove residual contaminates. 

� Adhesives and oils, for example, may be thinned by the initial cleaning 
but not completely removed. 

� Install the platen in the printer. Make sure the bearings and drive gear 
are on the shaft of the platen. 

� Align the platen with the gear to the left and lower it into the printer’s 
bottom frame. 

� Rotate the platen bearing latch release tabs down on the right and left 
sides towards the rear of the printer and snap them into place. 

� Allow the printer to dry for one minute before closing the dispenser 
door, media cover or loading labels. 
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Platen 
Bearings 

Release the latches 

Pull the platen and 
clean with the swab 

Align the platen 
with the gear 

Push down the latches to 
snap the planten in place 
platen with the gear 

1 

4 

2 

3 
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7.3 Media Path Considerations 

Use a cleaning swab to remove debris, dust or crust that has built-up on the holders, 
guides and media path surfaces. 

� Use the alcohol in the cleaning swab to soak the debris and to break up 
the adhesive. 

� Wipe the ridges to remove accumulated debris. 
� Wipe the inside edges of both edge guides to remove any built-up 

residue. 
� Wait one minute before closing the printer. 

 

 

Important – Using too much alcohol can result in contamination of the 
electronic components requiring a much longer drying time before the 
printer will function properly. 
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7.4 Cleaning the Sensors 
Dust can accumulate on the media sensors. 

� Gently brush away dust; if necessary, use a dry swab to brush away dust. If 
adhesives or other contaminates remain, use an alcohol moistened swab to 
break it up. 

� Use a dry swab to remove any residue that may be left from the first cleaning.  
� Repeat above steps as required until all residue and streaks are removed from 

the sensor. 
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Troubleshooting 

8.1 Status Light Error Resolutions 

� The printer is not receiving power. 
� Have you turned on the printer power? 
� Check power connections from the wall outlet to the power supply and 

from the power supply to the printer. 
� Disconnect the printer from the wall outlet for 30 seconds and then 

reconnect the printer to the wall outlet. 
� The printer is on and in an idle state. 

� No action necessary. 
� The printer has failed its power on self test (POST). 

� If this error occurs right after you turn on the printer, contact an 
authorized reseller for assistance. When the printer is operating 
normally, the printer status light will be amber for about 10 seconds 
before turning green (solid or blinking). 

� There is a memory error. 
� If this error occurs after you have been printing, turn the printer power 

off and on, and then resume printing. 
� The print-head needs to cool down. 

� If this error continues, turn the printer power off for five minutes or 
more, and then turn on. If the amber light persists, then the printer 
requires service. 

� The printer is receiving data. 
� As soon as all of the data has been received, the status LED will turn 

green and the printer will automatically resume operation. 
� The media is out. 

� Follow the instructions for Loading Roll Media in section 2.5 and then 
press the Feed button to resume printing.  

� The ribbon is out. 
� The printer has sensed the end of the ribbon roll. Replace the ribbon. 
� The print-head might be open. Close the top cover and then press the 

Feed button to resume printing.  
� The printer is paused. 

� ress the Feed button to resume printing. 
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� The print-head is over temperature. 
� Printing will stop until the print-head cools to an acceptable printing 

temperature. When it does, the printer will automatically resume 
operation. 

� FLASH memory is not programmed. 
� Contact BioGenex Technical Support. 

� The print-head or motor has had a critical failure. 
�  Contact BioGenex Technical Support.  

 
8.2 Print Quality Problems 

� No print on the label. 
� Is the media loaded correctly? Follow the instructions for Loading Roll 

Media (Section 2.4). For printing using transfer ribbon, refer to Thermal 
Ribbon Installation (Section 2.5.2) 

� The printed image does not look right. 
� The print-head may be dirty, clean it. 
� The print-head is under temperature. 
� Adjust the print darkness and/or print speed. 

a. Use the commands from the programming guide 
b. Manually adjust print darkness with the six-flash sequence of Feed 

Button Modes  (Section 8.3)  
� The print-head has worn out. The print-head is a consumable item and 

will wear out due to friction between the media and print-head. Replace 
the print-head. Contact BioGenex technical support. 

� The platen may need cleaning or replacement. The platen (driver) roller 
maybe losing traction due to: 
a. Foreign objects attached to its surface. 
b. The rubbery smooth surface has become polished and slippery, or 
c. There is damage to the normally smooth and flat print surface such 

as box knife cuts. 
� There are long tracks of missing print (blank vertical lines) on several labels 

� The print-head is dirty, clean it. 
� The print-head elements are damaged. 

� The printing does not start at the top of the label or misprinting of one to 
three labels. 

� The media may not be threaded correctly. Follow the instructions for 
Loading Roll Media – in section 2.4 
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� The printer needs to be calibrated. Refer to the flash sequence of Feed 
Button Modes (Section 8.3) 
 

� Manual Calibration 
Manual calibration is recommended whenever you are using pre-printed media 
or if the printer will not correctly auto calibrate. 

�  Make sure media is loaded. 
� Turn on the printer power. 
� There are two buttons present in Zebra printer 
� 1. Power Button 
� 2.  Flash Button 
� Hold the  Power button to turn on the printer ,it flashes red then green 
� Press the Flashs button,if it will flashes red means we missed  3 things 
�   Either the media/ribbon is empty,or the printer is not closed correctly 
� Once placed the media/ribbon then it turn into green colour. 
� Manual Calibration: 
� Press and hold the feed button until the green status light flashes once, 

then  release it after the status light flashes twice 
� The printer will set the media sensor for the label backing being used. 

After it is done making this adjustment, the roll will automatically feed 
until a label is positioned at the Print-head. A profile of the media sensor 
settings (similar to the example below) will print.  Upon completion, the 
printer will save the new settings in memory and the printer is ready  for 
normal operation. 

� Press the Feed button. One entire blank label will feed. If this does not 
happen, try defaulting (refer to the four-flash sequence in “Feed Button 
Modes” later in this chapter) and recalibrating the printer. 

� Install Printer Drivers: 
�  Insert the usb to the device then recognize the printer as shown below 
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Click on Printer properties as shown 

 

Click on Print Test page to see the printed label  
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8.3 Troubleshooting Feed Button Modes 

Power On Modes 

With the printer power on and top cover closed, press and hold the Feed button for several seconds. The green 
status LED will flash a number of times in sequence. The explanation at the right (Action) shows what happens 
when you release the key after the start specific number of flashes and before the next flash sequence starts. 

Flash Sequence Action 

  
  

* 
** 

*** 
**** 

***** 
****** 

Print Darkness (Density) Adjustment - Prints a succession of bar code simulation patterns 
starting at the minimum darkness (print density/heat) and ending in the printer’s maximum 
darkness in increments of four (4) using the ZPL darkness setting range values. Press the Feed 
button once the pattern is clear and legible. Do not continue to increase the  darkness setting. 
Bar code line widths may become distorted reducing readability. Note that the printer driver 
and applications can override this setting. 
 

  
If the Feed button remains pressed after a 8-flash sequence, the printer exits the configuration mode when the 
Feed button is released. 

 

Please contact BioGenex Technical Support for calibration and troubleshooting. 

 

8.0 Technical Support 
For further inquiries and/or product ordering, please contact: 

 

 
BioGenex Tech Support: 1-800-421-4149 
 
Email: support@biogenex.com  
 
 
Please visit our website to obtain more information about our products  
www.biogenex.com 
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